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Product Overview

In this section...

“Overview of Polyspace Verification” on page 1-2

“The Value of Polyspace Verification” on page 1-2

Overview of Polyspace Verification

Polyspace® products verify C, C++, and Ada code by detecting run-time errors
before code is compiled and executed. Polyspace verification uses formal
methods not only to detect errors, but to prove mathematically that certain
classes of run-time errors do not exist.

To verify the source code, you set up verification parameters in a project, run
the verification, and review the results. A graphical user interface helps you
to efficiently review verification results. Results are color-coded:

¢ Green — Indicates code that never has an error.

®* Red — Indicates code that always has an error.

¢ Gray — Indicates unreachable code.

¢ Orange — Indicates unproven code (code that might have an error).

The color-coding helps you to quickly identify errors and find the exact

location of an error in the source code. After you fix errors, you can easily run
the verification again.

The Value of Polyspace Verification
Polyspace verification can help you to:

¢ “Ensure Software Reliability” on page 1-3
® “Decrease Development Time” on page 1-3

¢ “Improve the Development Process” on page 1-4




Product Overview

Ensure Software Reliability

Polyspace software ensures the reliability of your C++ applications by proving
code correctness and identifying run-time errors. Using advanced verification
techniques, Polyspace software performs an exhaustive verification of your
source code.

Because Polyspace software verifies all possible executions of your code, it
can identify code that:

® Never has an error
e Always has an error
® Js unreachable

e Might have an error

With this information, you know how much of your code is free of run-time
errors, and you can improve the reliability of your code by fixing errors.

You can also improve the quality of your code by using Polyspace software to
check that your code complies with established C++ coding standards, such as
MISRA® C++:2008 or JSF++:2005.

Decrease Development Time

Polyspace software reduces development time by automating the verification
process and helping you to efficiently review verification results. You can use
it at any point in the development process. However, using it during early
coding phases allows you to find errors when it is less costly to fix them.

You use Polyspace software to verify C++ source code before compile time. To
verify the source code, you set up verification parameters in a project, run
the verification, and review the results. This process takes significantly less
time than using manual methods or using tools that require you to modify
code or run test cases.

Color-coding of results helps you to quickly identify errors. You will spend

less time debugging because you can see the exact location of an error in the
source code. After you fix errors, you can easily run the verification again.
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Using Polyspace verification software helps you to use your time effectively.
Because you know which parts of your code are error-free, you can focus on
the code that has definite errors or might have errors.

Reviewing code that might have errors (orange code) can be time-consuming,

but Polyspace software helps you with the review process. You can use filters
to focus on certain types of errors or you can allow the software to identify the
code that you should review.

Improve the Development Process

Polyspace software makes it easy to share verification parameters and
results, allowing the development team to work together to improve product
reliability. Once verification parameters have been set up, developers can
reuse them for other files in the same application.

Polyspace verification software supports code verification throughout the
development process:

¢ An individual developer can find and fix run-time errors during the initial
coding phase.
® Quality assurance engineers can check overall reliability of an application.

¢ Managers can monitor application reliability by generating reports from
the verification results.
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Product Components

In this section...

“Polyspace Products for C++” on page 1-5
“Polyspace Verification Environment” on page 1-5

“Other Polyspace Components” on page 1-10

Polyspace Products for C++
The Polyspace products for verifying C++ code are combined with the

Polyspace products for verifying C code. These products are:

e Polyspace® Client™ for C/C++

e Polyspace® Server™ for C/C++

Polyspace Client for C/C++ software is the management and visualization tool

of Polyspace products. You use it to submit jobs for execution by the Polyspace
Server, and to review verification results.

Polyspace Server for C/C++ software is the computational engine of Polyspace
products. You use it to run jobs posted by Polyspace clients, and to manage
multiple servers and queues.

Polyspace Verification Environment

The Polyspace verification environment (PVE) is the graphical user interface
of the Polyspace Client for C/C++ software. You use the Polyspace verification
environment to create Polyspace projects, launch verifications, and review
verification results.

The Polyspace verification environment consists of three perspectives:

® “Project Manager Perspective” on page 1-6
e “Coding Rules Perspective” on page 1-8

¢ “Run-Time Checks Perspective” on page 1-9

1-5
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Project Manager Perspective

The Project Manager perspective allows you to create projects, set verification
parameters, and launch verifications.
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You use the Project Manager perspective in the tutorial in Chapter 2, “Setting

Up a Polyspace Project”.

Coding Rules Perspective

The Coding Rules perspective allows you to review results from the Polyspace
coding rules checker, to ensure compliance with established coding standards.

PolySpace - C:\PolySpace\Training_Project\Verification_(2)\Result_(1)\PolySpace-Doc)\ISF-reportxml

File Edit Run Review Options Window H

GREN=NE RN

elp

9| o]

‘ lf} Project Manager | ~& Coding Rules -~ Run-Time Checks

~1ol x|

TEFCH e a
Filter I I™ Hide justifed violated rules

i
wje Rule File Line Col Classification Status Justified Comment
warning training.cpp 21 &[Mot a defect Mo action planned e
training.cpp . Fix Mow
Hwarning  |180 training.cpp 109 15|Low Justify with annotations v Low Risk
“lwarning 180 training.cpp 142 38 (i

Rule detai

File: C:\Poly3pace\polyspace projecti\sources‘\training.cpp line 48 (column 1%9)

Bule: 191 (error): The break statement shall not be used (except to terminate the cases of a switch statement).

Ready

You use the Coding Rules perspective in the tutorial in Chapter 5, “Checking
Compliance with Coding Rules”.
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comment individual checks, and track review progress.

PolySpace\T
Review Options Window Help

Project\Verification_(1)\Res:

Review Details

_(2)\RTE_px_Traini

Project_LAST_RESULTS.rte

\ctive Source Code | ¥ I

~lere J|

Review Statistics

| L’i} Project Manager |- Coding Rules | <% Run-Time Checks

=10l

Ched
F| % |

tatisti

§ i]lli Coding review progress Count |Progress
" - - - Red NTC justified [ to justify 0f1 [i]
i training. MathLtils: :Recursion_caller(} /line 124 / column 13
Procedural entities L 8| o pp f el / Red justified / to justify 02 0
|25 Training_Froject z @ Recursion( sx ); // elways encounters & division by zero Gray justified / to justify o/1 0
[)-training.h 100 . y | |Orange justified / to justify 1ja 18
- exosption stdh o C‘Es:‘ﬁca""” _If‘a‘“s _Ijl‘f“ﬁEd Comment  [Software reliabilty indicator 73788 8
Hi x||Fix x [Fixx Naw |
[#-new stdh 0 g I g
[¥]-sysmacras.h O |fche training.MathUcils::Recursion(int*} call never terminates
Bt - St WWunreachable : call to Recursion does not i
82
100
E - Check Details |-§'- Expanded Sourc.. | @ Review Statistics
80 - Cal =
o I 4 B 2%
100 | [ F2ining PP _polyspace_main.cpp | M, (44
ur =l
120 !
120 | ~ W pst_stubs_ Utils: random_int(} 120
123 117 void MathUrils::Recursion caller () ~ B pst_stubs_Utils: random_int() 123
123 118 ! B training. MathUtils:: Recursion{int”] 124
124 12 If“"lls ur . B pst_stubs_ Utils: random_int]} 27
124 120 int x=u.rendon_inc(); B training MathUtils:: Recursion(int") 128
1277 iz; a w4 _pohyspace_main main 10
x = -4;
= 123 if {u.ramdom_int(} > O}
28 124 Recursion( &x }: /¢ always encounters a division by zero
- RTE: test]) e o | 125 J e s
. Squars::Squars_Flwot]) 148 0 126 x® = 10; Varizbles
- Square::Square_F|ot_conv(# wolo |f1z7 if {uw.random_int(} > 0) Traiming_Proct
- Square::Unreachs|ile_Coda() 184| 0 1z8 Recursion( &x )} // never encounters a diwvision by zero
[&-_polyspace_stistutf.c vlo [z -—
[#]-_polyspscs_stdstutficpn.cpp 1|0 130
- 1 oo )l 131
J [v]f 132 =
133 /% Hara wa demonatifate PoluSnacs Warifier!s ahilits tn trace n
- Run-Time Checks | - Assistant Chedks | 4 i j < | i
[ 0% Training_Project  Source file: _polysp|ce_main.cpp  _polyspace_main.cpp  Line:1  Column: unknwn
Run-Time Source Variable Call
Checks code Access Hierarchy

You use the Run-Time Checks perspective in the tutorial in Chapter 4,
“Reviewing Verification Results”.
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Other Polyspace Components

In addition to the Polyspace verification environment, Polyspace products
provide several other components to manage verifications, improve
productivity, and track software quality. These components include:

¢ Polyspace Queue Manager Interface (Spooler)
e Polyspace in One Click
¢ Polyspace Metrics Web Interface

Polyspace Queue Manager Interface (Polyspace Spooler)

The Polyspace Queue Manager (also called the Polyspace Spooler) is the
graphical user interface of the Polyspace Server for C/C++ software. You
use the Polyspace Queue Manager Interface to move jobs within the queue,
remove jobs, monitor the progress of individual verifications, and download
results.

E PolySpace Queue Manager Interface - | m| | ﬂ

Operationzs  Help

1D Author Application Results folder CPU Status Date Language
e PalySpace |Demo_C C:\PolySpace\PaolySpaceForCandCPP_. .. [runstr... (completed |14-Dec-2009, ... [C
5 polyspace |\Demo_C_Single_File |C:\PolySpace\PolySpaceForCandCPP_. .. [runstr... |completed |14-Dec-2009, ... |C
-8 PolySpace Demo_C C:'\PolySpace\polyspace_projectiresults completed |17-Dec-2009, ... [C

username

olySpacepolyspace_projectiesults runstr... running  |06-Jan-2010, ... (CPP

Connected to Queue Manager localhost User mode

You use the Polyspace Queue Manager in the tutorial “Launching Server
Verification from Project Manager” on page 3-10.

Polyspace in One Click

Polyspace in One Click is a convenient way to verify multiple files using the
same set of options.

After creating a project with the options that you want, you can use Polyspace
in One Click to designate that project as the active project, and then send
source files to Polyspace software for verification with a single mouse click.




Product Components

You use Polyspace in One Click in the tutorial “Using Polyspace In One Click
to Launch Verification” on page 3-21.

Polyspace Metrics Web Interface

Polyspace Metrics is a web-based tool for software development managers,
quality assurance engineers, and software developers. Polyspace Metrics
allows you to evaluate software quality metrics, and monitor changes in code
metrics, coding rule violations, and run-time checks through the lifecycle

of a project.

For information on using Polyspace Metrics, see “Software Quality with
Polyspace Metrics”in the Polyspace Products for C++ User’s Guide.
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Installing Polyspace Products

In this section...

“Finding the Installation Instructions” on page 1-12

“Obtaining Licenses for Polyspace® Client for C/C++ and Polyspace® Server
for C/C++ Products” on page 1-12

Finding the Installation Instructions

The tutorials in this guide require both Polyspace Client for C/C++ and
Polyspace Server for C/C++ products. Instructions for installing Polyspace
products are in the Polyspace Installation Guide. Before running Polyspace
products, you must also obtain and install the necessary licenses.

Obtaining Licenses for Polyspace Client for C/C++
and Polyspace Server for C/C++ Products

See “Polyspace License Installation” in the Polyspace Installation Guide for
information about obtaining and installing licenses for Polyspace products.
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Working with Polyspace Software

In this section...

“Basic Workflow” on page 1-13

“Tutorials in This Guide” on page 1-14

Basic Workflow

The following graphic shows the basic workflow for using Polyspace software
to verify C++ source code.

Setup project

Verify code

3
Review verification results

In this workflow, you:

1 Use the Project Manager perspective to set up a project file.

2 Verify code on a server or client.

You can use the Project Manager perspective to start the verification or
you can select files from a Microsoft® Windows® folder and send them to
the Polyspace software for verification. For verifications that run on a

server, you can use the Spooler to manage the verifications and download
the results to a client.

3 Use the Run-Time Checks perspective to review verification results.

1-13
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Tutorials in This Guide

The tutorials in this guide take you through the basic workflow, including the
different options for running verifications. The workflow that you will follow
in this guide is:

Create new project

Verify code

-

3
Review verification results

In this workflow, you:

1 Create a new project that you use for the workflow.
This step is in the tutorial Chapter 2, “Setting Up a Polyspace Project”.
2 Verify a single class using demo C++ source code.

This step is in the tutorial Chapter 3, “Running a Verification”. In this
tutorial, you will verify the same class using three different methods for
running a verification. You will:

e Start a verification that runs on a server using the Project Manager
perspective.

® Send files to a server for verification using Polyspace In One Click.

e Start a verification that runs on a client using the Project Manager
perspective.

3 Review the verification results.

1-14
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This step is in the tutorial Chapter 4, “Reviewing Verification Results”.

4 Modify the project to include coding rules checking and review the JSF++
rule violations in the example file.

This step is in the tutorial in Chapter 5, “Checking Compliance with
Coding Rules”.

1-15
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Additional Information and Support

In this section...

“Product Help” on page 1-16
“MathWorks Online” on page 1-16

Product Help

To access Polyspace online Help, select Help > Help .

To access the online documentation for Polyspace products, go to:
/www.mathworks.com/access/helpdesk/help/toolbox/polyspace/polyspace.html
MathWorks Online

For additional information and support, see:

www.mathworks.com/products/polyspace
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Related Products

Related Products

In this section...

“Polyspace Products for Verifying C Code” on page 1-17
“Polyspace Products for Verifying Ada Code” on page 1-17

“Polyspace Products for Linking to Models” on page 1-17

Polyspace Products for Verifying C Code

For information about Polyspace products that verify C code, see the following:
http://www.mathworks.com/products/polyspaceclientc/
http://www.mathworks.com/products/polyspaceserverc/

Polyspace Products for Verifying Ada Code

For information about Polyspace products that verify Ada code, see the
following:

http://www.mathworks.com/products/polyspaceclientada/
http://www.mathworks.com/products/polyspaceserverada/

Polyspace Products for Linking to Models

For information about Polyspace products that link to models, see the
following:

http://www.mathworks.com/products/polyspacemodelsl/

http://www.mathworks.com/products/polyspaceumlrh/
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e “About Setting Up a Project Tutorial” on page 2-2

e “Creating a New Project” on page 2-3
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About Setting Up a Project Tutorial

In this section...

“Overview” on page 2-2

“Example Files” on page 2-2

Overview

You must have a project before you can run a Polyspace verification of your
source code. In this tutorial, you create the project that you use to run
verifications in later tutorials.

Example Files

In this tutorial, you will verify the class MathUtils in the source file
training.cpp that comes with the Polyspace installation CD. You can learn
more about the files and folders required for this tutorial in “Preparing the
Project Folders” on page 2-4.
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Creating a New Project

In this section...

“What Is a Project?” on page 2-3
“Preparing the Project Folders” on page 2-4
“Opening Polyspace Verification Environment” on page 2-5

“Creating a New Project to Verify a Class in the Training C++ File” on
page 2-7

What Is a Project?

In Polyspace software, a project is a named set of parameters for verification
of your software project’s source files. A project includes:

® Source files
¢ Include folders
* One or more configurations, specifying a set of analysis options
® One or more verifications, each of which include:
= Source (specific versions of source files used in the verification)

= Configuration (specific set of analysis options used for the verification)

= Verification results

You can create your own project or use an existing project. You create and
modify a project using the Project Manager perspective.

In this tutorial, you create a new project and save it as a configuration file
(.cfg).
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Preparing the Project Folders

Before you start verifying C++ code with Polyspace software, you must know
the locations of the C++ source file and the include files. You must also know
where you want to store the verification results.

For each project, you decide where to store source files and results. For
example, you can create a project folder and then create separate folders for
the source files and include files within the project folder.

For this tutorial, prepare a project folder as follows:

1 Create a project folder named polyspace_project.

2 Open polyspace_project, and create the following folders:
® sources

e includes

3 Copy the file training.cpp from
Polyspace_Install\Examples\Demo_Cpp_Long\sources
to
polyspace_project\sources
where Polyspace Install is the installation folder.

4 Copy the files training.h and zz_utils.h from
Polyspace_Install\Examples\Demo_Cpp_Long\sources
to

polyspace_project\includes.



Creating a New Project

Opening Polyspace Verification Environment

You use the Polyspace verification environment to create projects, start
verifications, and review verification results.

To open the Polyspace verification environment:

1 Double-click the Polyspace icon.

2 If you have only Polyspace Client for C/C++ software installed on your
computer, skip this step. If you have both Polyspace Client for C/C++ and
Polyspace Client for Ada products on your system, the Polyspace Language
Selection dialog box opens.

x

Select a language

¥ PolySpace for CIC++

™ PolySpace for Ada

oK I Cancel

3 Select Polyspace for C/C++ and click OK.

The Polyspace Verification Environment opens.
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Specify source files Set target environment Specify
and include folders and check compilation analysis options
]
[ —— = Te]
File Edit Run Review| Options Window Help
%E)BHP} (‘| & %@|% ‘-‘@'Search: - '®H |E Project Manager | - Coding Rules - Run-Time Checks
D Run ¥ . Stop | |2 new result folder Use result folder: |Resu\t_3 - |
-.E]|ﬁ’.|9|1 ‘|@ bChechompllaﬁoﬂ .Stup
E--E example_project [C] Target Environment B
E-3 Source
585 sources Target ceratng systen: Torget procesor tpe: 35
\j example.d|
3 Include Compiler Dialect
- . Aincludes ‘
£+ 5 Verification_1 BL==8
=+ Souree E
| BE® sources Compilation Macros Active Settings
|| example.c + X b3
Configuration )
H . Macro Description Option
H E example_project
217 Result Ignore assembly code [-discard-asm
: B N . Allow negative operand f|r left shifts -allow-negative-operand-n-shift |
13 Result 2 [Verf\caton Completed] ‘Acceptintegral type con|cts Cpermissive-ink L4
! [Verification Completed] Allow language extensior|: -allow-anguage-extensions =
I E options T
-] RTE_px_example_project_L AST_RESULTS.rte g mple_project /Verification_1 / Configuration /
B3 Verification_2 %‘?
E+E3 Source
| BE® sources | Name Value Internal name
i |_°| example.c | analysis options g
13 Configuration | & General
E example_project Send to Polyspace Server -server
- E examp\a_project 1 Add to results repository -add-to-results-repository L
E| 23 Result - - Keep all preliminary results files keep-all-files 1
-3 Result_4 [Verification Completed] Calculate code metrics ~code-metrics
E options [=-Report Generation
: E RTE_py_exa +-Report template name Developer - -report-template
) MIS_RA—_C—repurtxml *~-Output format RTF = -report-output-format
- rules_project [C] - Target/Compilation i

@ Qutput Summary - [C:\PolySpace'polyspace_project\Verification_1\Result_3]
search: 4 +

Class Description File Line Col

t
4 processars have been detected. Taking advantage of multipro...
i rThe generated default DRS XML file “drs-template, xml" can be f... | ‘

Detail:

Information:
example_project for C verification start at Dec 15, 2010 18:54:41

i Verification Statistics Progress Monitor Output Summary

<

' 0% | Ready

Monitor progress and view logs
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By default, the Polyspace Verification Environment displays the Project
Manager perspective. The Project Manager perspective has three main panes.

Use this For...
section...

Project Browser | Specifying:
(upper-left) ® Source files

® Include folders

® Results folder

Configuration Specifying analysis options
(upper-right)

Output Monitoring the progress of a verification, and viewing
(lower-right) status, log messages, and general verification statistics.

You can resize or hide any of these panes. You learn more about the Project
Manager perspective later in this tutorial.

Creating a New Project to Verify a Class in the
Training C++ File

You must have a project, saved with file type .cfg, to run a verification. In
this part of the tutorial, you create a new project to verify training.cpp.

You create a new project by:

“Opening a New project” on page 2-7

“Specifying Source Files and Include Folders” on page 2-10
“Specifying Target Environment” on page 2-11

“Specifying Analysis Options” on page 2-12

“Saving the Project” on page 2-15

Opening a New project
To open a new project for verifying training.cpp:
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1 Select File > New Project.

The Polyspace Project — Properties dialog box opens:

PolySpace Project - Properties ﬂ

~Project definition and location

Project name: ITraining_F‘ru:uject

Version: |1.D

Authaor: Iusername

[T Default location

Location: |C:\PaolySpace‘polyspace_project E‘l

~Project language
- C
f* C++

Back Mext Finish Cancel

2 In the Project name field, enter Training_Project.

3 Clear the Default location check box.

Note Clearing the Default location check box allows you to specify
the location of your project files. In this tutorial, you change the default
location to the project folder that you created in “Preparing the Project
Folders” on page 2-4. Changing the default location makes it easier to
specify source files and include folders.




Creating a New Project

4 In the Location field, enter or navigate to the project folder that you
created earlier.

In this example, the project folder is C: \Polyspace\polyspace_project.
5 In the Project language section, select C++.
6 Click Finish.

The Training Project opens in the Polyspace verification environment.

PolySpace C:\PolySpace\Training_Project\Training_Project.clg - 1ol =l
File Edit Run Review Options Window Help

= | | i BB ‘ By " | 7} |Search in: | Configuration View vl LI Y] | |r__"j Project Manager -3 CodingRules -5} Run-Time Checks
P Run . Stop | [¥ Create new result folder  Use result Folder:l LI

=" Project Browser s Configuration - [Training_Project / Verification_(1) [ Configuration f Training_Project]
T IELEEE 12
- Training_Project [C++] Mame Value Internal name

I3 Source Analysis options
53 Include [=I-General

£ ... include-gnu --5end to PolySpace Server = -server
: £33 ... indude-gnu'next ---Add to results repository - -add-to-results-repository
B | Verification_(1) -Keep al preliminary results files [} -keep-all-files
; & Source Calculate code metrics [l -code-metrics
= | Configuration [E-Report Generation -
4 Training_Project -Report template name C:\PolySpace\PolySpace_Common'| ... |report-template
I3 Result i.-Output format RTF - -report-output-format

|- Target/Compilation

+]-Compliance with standards
|- PolySpace inner settings
3]
3]

mhmlmElm

Precision/Scaling
- Multitasking

Cutput Summary

Class Description File Line Caol
[ I

Detail:

@ Ful Log | ﬁ Verification Statistics Progress Monitor Qutput Summary

0% Ready
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Specifying Source Files and Include Folders
To specify the source files and include folders for the verification of

training.cpp:

1 In the Project Browser, select the Source folder.

2 Click the Add source icon

. in the upper left the Project Browser.

The Polyspace Project — Add Source Files and Include Folders dialog box

opens.

PolySpace Project - Add Source Files and Include Folders

Look in: I[E:] polyspace_project

= 2 eEE

¥ Add recursively | .| + ¥

(T3 includes Ey_a Training_Project [C++]
() results E}@ Source
|C5) sources EIB SOUrCEs
E] training.cpp
B3 Indude
£ ... \indude-gnu
a »Jdindude-gnutnext
wff) . Yindudes
]
”
My Computer
“
My Network
Places
File name: Iindudes | Add Source |
Files of type: Iv[‘.q:.p)J {*.cc) and (*.c) files LI 1| Add Incude |
Back | Mext | Finish | Cancel |

2-10

3 The project folder polyspace_project should appear in Look in. If it does

not, navigate to that folder.

4 Select the sources folder, then click Add Source.

The training.cpp file appears in the Source tree for Training Project.
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5 Select the includes folder, then click Add Include.

The includes folder appears in the Include tree for Training Project.

Note In addition to the include folders you specify, Polyspace software
automatically adds the standard include folders to your project.

6 Click Finish to apply the changes and close the dialog box.

The Project Browser now looks like the following graphic.

+ AW S| 8B
E|,_} Training_Project [C++]

E}L'j' Source
Elh SoUrces

I?] training.cpp

> ¢ e

B 1 indude-gnu

=1 Verification_{1)
. ----- & Source
E|l,-j' Configuration
E~----|ETrail‘uing_F‘ru:quu:t
[T Result

Specifying Target Environment

Many applications are designed to run on specific target CPUs and operating
systems. Since some run-time errors are dependent on the target, you must

specify the type of CPU and operating system used in the target environment
before running a verification.
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The Compilation Assistant window in the top-right section of the Project
Manager perspective allows you to specify the target operating system and
processor type for your application.

To specify the target environment for this tutorial:

1 In the Target operating system drop-down menu, select
no_predefined_OS.

L——:—————__

B Check Compilation @ Stop

Target Environment

,: Target processor type: :i386 ,:

Compiler Dialect

Dialect: | default -

2 In the Target processor type drop down menu, select 1386.

For more information about emulating your target environment, see “Setting
Up a Target’in the Polyspace Products for C User’s Guide.

Specifying Analysis Options

The Configuration window in the middle-right section of the Project Manager
perspective allows you to set Analysis options that Polyspace software uses
during the verification process.

For more information about analysis options, see “Options Description” in the
Polyspace Products for C++ Reference.

To specify the analysis options for this tutorial:

1 In the Configuration pane, expand the Polyspace inner settings section.
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. Configuration - [Training_Project [ Verification_(1) / Configuration [ Training_Project]

L2

Mame Value Internal name

Analysis options

[+--General
[#-Target/Compilation
[H-Compliance with standards
B [#-Run a verification unit by unit Il -unit-by-unit
[+-Specify a Visual Studio compliant main -
[El-Generate a main v -main-generator
H-Class name custom ¥ | ... |-class-analyzer
-Function calls unused * | ... |-main-generator-calls
--First functions to call ... |-function-called-before-main
- \Write accesses to global variables uninit « | ... |-main-generator-writes-variables
[-Stubbing
[#-Assumptions
-Run verification in 32 or 64-bit mode auto - -machine-architecture
~Mumber of processes for multiple CPU core systems |4 -Max-processes
- Other options
[#-Predsion/Scaling
[H-Multitasking

2 Select the Generate a main check box.

This enables the -class-analyzer option and allows you to specify the
class you want to verify.

3 Expand the Generate a main section.
4 In the Class name drop-down menu, select custom.
5 Select the browse button in the Class name row.

6 The Class name dialog box opens.
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x

~Class name [-dass-analyzer]

|Maﬂn|.|ﬁ|s| _1-%_ ill

QK Cancel |

o

7 Enter MathUtils in the Class name field, then select the Add item
button.

8 MathUtils is added to the list of classes.
9 Click OK. to save your changes and close the dialog box.

10 Keep the default values for all other analysis options.

Note You can also select the -class-only option when you want to verify a
single class. When this option is applied, even if you add other classes and
function member definitions, Polyspace will stub them. This accelerates your
verification process and allows you to check robustness issues for a single
class. For the purposes of this tutorial, it is not necessary to select this option
because the class MathUtils does not depend on any other classes.




Creating a New Project

Saving the Project
To save the project, select File > Save.

Polyspace software saves your project using the Project name and Location
you specified when creating the project.
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Running a Verification

® “About Running a Verification Tutorial” on page 3-2

® “Preparing for Verification” on page 3-4

¢ “Launching Server Verification from Project Manager” on page 3-10
¢ “Using Polyspace In One Click to Launch Verification” on page 3-21

¢ “Launching Client Verification from Project Manager” on page 3-28
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About Running a Verification Tutorial

In this section...

“Overview” on page 3-2

“Before You Start” on page 3-3

Overview

Once you have created the project Training_ Project.cfg as described in
“Creating a New Project” on page 2-3, you can run the verification.

You can run a verification on a server or a client.

Use...

FOI‘...

Server

¢ Best performance

Large files (more than 800 lines of code including comments)

Multitasking

Client

® An alternative to the server when the server is busy

Small files with no multitasking

Note Verification on a client takes more time. You might
not be able to use your client computer when a verification is
running on it.

You can start a verification using the Launcher or using Polyspace In One
Click. With either method, the verification can run on a server or a client.



About Running a Verification Tutorial

Use... For...

Project Manager A basic way to start a verification.

You specify the source files in the project file.
With the project open, you click a button to start
the verification.

Polyspace In One Click | A convenient way to start the verification of
several files which use the same verification
options.

Once you specify the project file containing the
verification options, you specify the source files
by selecting them from a Microsoft Windows
folder. You start the verification by sending the
selected files to Polyspace software.

In this tutorial, you learn how to run a verification on a server and on a client,
and how to start a verification using the Project Manager and Polyspace In
One Click. You verify the class MathUtils in the file training.cpp three
times using a different method each time. You use:

® Project Manager to start a verification that runs on a server.

¢ Polyspace In One Click to start a verification that runs on a server.

® Project Manager to start a verification that runs on a client.

Each verification stores the same results in your project. You review these
results in the tutorial Chapter 4, “Reviewing Verification Results”.

Before You Start

Before you start this tutorial, you must complete Chapter 2, “Setting
Up a Polyspace Project”. You use the folders and project file,
Training_Project.cfg, from that tutorial to run the verifications.
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Preparing for Verification

3-4

In this section...

“Opening the Project” on page 3-4
“Specifying Source Files to Verify” on page 3-4
“Checking for Compilation Problems” on page 3-5

Opening the Project

To run a verification, you must have an open project. For this tutorial, you
use the project file Training Project.cfg that you created in Chapter 2,

“Setting Up a Polyspace Project”. Open Training Project.cfg if it is not
already open.

To open Training Project.cfg:

1 If the Polyspace software is not already open, open it.
2 Select File > Open Project.
The Open a Polyspace project file dialog box opens.
3 In the Look in drop-down list box, navigate to polyspace_project.
4 Select Training_Project.cfg.

5 Click Open to open the file and close the dialog box.

Specifying Source Files to Verify

Each Polyspace project can contain multiple verifications. Each of these
verifications can analyze a specific set of source files using a specific set of
analysis options.

Therefore, before you launch a verification, you must specify which files in
your project you want to verify. In the Training_ Project in this tutorial,

there 1s only one file to verify.

To copy source files to a verification:




Preparing for Verification

1 In the Project Browser Source tree, right click training.cpp.
2 Select Copy Source File to > Verification_(1).

The training.cpp file appears in the Source tree of Verification (1).

F Browse|

Pl |+ |E
=) Training_Project [C++]
B3 Source
EES sources
@ training.cpp
B3 Indude
£ 1. Yncdude-gnu
-5 .. indude-gnunext
£ .. Yndudes
=== Verification_{1)
B3 Source
E}ﬁ SOUrCES
E-F Configuration
E Training_Project
I3 Result

Checking for Compilation Problems

The Compilation Assistant allows you to check your project for compilation
problems before launching a verification. When the Compilation Assistant
detects an error, it reports the problem and suggests possible solutions.

To check your project for compilation problems:

1 In the Project Browser Source tree, right click the Include folder
(. .\includes), then select Remove. This will cause a compilation error.
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“" Project Browser

YA B| S|+ E

- @ example_project [C]
=N 5 Source
=t ﬁ SOUrCEs

Delete

e 5] Project Propertles

Alt+P

EI = Conﬂguratlon
|14 example_project

...... & Result

" Compilation Assi

P Check Compilation | ¥ Stop

nt - [example_project f Verification_1 / Configuration [ example_project]

2 In the Compilation Assistant window, click Check Compilation.

Target Environment s
Target operating system: Target processor type: 385 = Edit
Compiler Dialect

Datect

Compilation Macros Active Settings

+* X X

Macro Description Option
Ignore assembly code -discard-asm

Allow negative operand for left shifts

-allovs-negative-operand-in-shift

Accept inteagral type conflicts

-permissiveink

Allow language extensions

-allow-anguage-extensions

Allow nion int types for bitfields

-allow-non-int-bitfield

Allow anonymous unionsstructure fields

-allow-unnamed-fields

Code from DOS or Windows filesystem

-dos

Allow undefined global variables

-allow-undef-variables
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The software compiles your code and checks for errors, and reports the
results in the Output Summary.

@ Preprocessing Errors: 2

Type File Line Message SuggestionRemark Action
f |example.c (1 |could not open source file "math.h” Add indude folder for: math.h | Add.. |
f |example.c (2 |could not open source file findude.h®  |Add indude folder for: indude.h | Add.. |

Because you removed the include folder, the software reports a compilation
error for the project, along with suggested solutions for the problem.

3 Select the Suggestion/Remark column to see a list of possible solutions
for the problem.

@ Preprocessing Errors: 2 | [] Filter warnings {0)
Type File Line Message Suggestion/Remark Action
? |example.c |1 |could not open source file "math.h” Add indude folder for: math.h | Add.. |
g | Ciud Sl Ciud O Ciud A.dd. “

Add indude folder for: indude.h

In this case, you can either add the missing include file, or set an option
that will attempt to compile the code without the missing include file.

4 Select Set option: -ignore-missing-headers, then click Apply.

5 The software automatically sets the option Ignore missing header files
for your project, and displays the option in the Compilation Assistant
Active Settings table.
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Active Settings

X

Description Option

Ignore assembly code -discard-asm

Allow negative operand for left shifts  |-allow-negative-operand-in-shift
Accept intearal type conflicts -permissive-ink

Allow language extensions -gllow-anguage extensions
Allow non int types for bitfields -allow-non-int-bitfield

Allow anonymous unionsstructure fields [-allow-unnamed-fields
Code from DOS or Windows filesystem  |-dos

Allow undefined global variables -allow-undef-variables

6 Select Check Compilation to check your project again.

The same errors appear, since the code cannot be compiled without
include.h.

7 In the Output Summary window, select Add include folder for:
include.h, then click Add.

The Add Source Files and Include Folders dialog box opens.
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PolySpace Project - Add Source Files and Include Folders

Look in: IE] polyspace_project

=l 2 eEE

|7Addreu.rs;’vely|.| + ¥

= I3 indludes Et"’j Training_Project [C++]
@ 1) results E}B Source
Desktop ) sources . EMED sources
E] training.cpp
ﬁ B3 Indude
A5 ... indude-gnu
My Documents A5 .. Nindude-gnu'pext
“AE) . indudes
mathworks
-
=
My Computer
My Metwork
Places
File name: Iindudes | Add Source |
Files of type: I(".q:lp}, (*.cc) and (%.¢) files ﬂ | Add Indude |
Back | Iext | Finish Cancel

8 If necessary, navigate to the polyspace_project folder.

9 Select the includes folder, then click Add Include.

The includes folder appears in the Include tree for example project.

10 Click Finish.

11 Select Check Compilation in the Compilation Assistant to check your

project again.

The message Compilation succeeded appears in the Output Summary.

@ Compilation succeeded

Type File

SuggestionRemark

|Com|:u'|ah'on succeeded Fiﬁrta code verification by dicking "Run”in the main toolbar.

Action
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Launching Server Verification from Project Manager

In this section...

“Starting the Verification” on page 3-10
“Monitoring Progress of the Verification” on page 3-12
“Removing Verification Results from the Server” on page 3-18

“Troubleshooting a Failed Verification” on page 3-19

Starting the Verification

In this part of the tutorial, you run the verification on a server.
To start a verification that runs on a server:

1 Select the Send to Polyspace Server check box in the General Analysis
options.

Mame Value Internal name

Analysis options

El-General
----- Send to PolySpace Server Vv -Server
----- Add to results repository - -add-to-results-repository
----- Keep all preliminary results files r +eep-all-files
----- Calculate code metrics r -code-metrics
[=-Report Generation r
----- Report template name Z:'Polyspacef ... |-report-template
----- Cutput format RTF - report-output-format

2 Click the Run button M on the Project Manager toolbar.

Note If you see the message Verification process failed, click OK
and go to “Troubleshooting a Failed Verification” on page 3-19.




Launching Server Verification from Project Manager

The verification has three main phases:

Checking syntax and semantics (the compile phase). Because Polyspace
software 1s independent of any particular C++ compiler, it ensures that

your code is portable, maintainable, and complies with ANSI® standards.

Generating a main if it does not find a main and the Generate a Main
option is selected. For more information about generating a main, see
in the Polyspace Products for C++ Reference.

Analyzing the code for run-time errors and generating color-coded
diagnostics.

The compile phase of the verification runs on the client. When the compile
phase is complete:

You see the message queued on server at the bottom of the Project
Manager perspective. This message indicates that the part of the
verification that takes place on the client is complete. The rest of the
verification runs on the server.

A message in the Output Summary window gives you the identification
number (Analysis ID) for the verification. For this verification, the
identification number is 1.

Class Description File Line Cal
1 |example_project for C verification start at Jun 4, 2010 11:24:338
1 [The generated default DRS XML file "drs-template. xml” can be found in <result_dir= folder,

Analysis ID : 1

3 For information on any message in the log, click the message.
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Monitoring Progress of the Verification

There are two ways to monitor the progress of a verification:
¢ Using the Project Manager — allows you to follow the progress of the
verifications you submitted to the server, as well as client verifications.

¢ Using the Queue Manager (Spooler) — allows you to follow the progress
of any verification job in the server queue.

Monitoring Progress Using Project Manager

You can monitor the progress of your verification by viewing the progress
monitor and logs at the bottom of the Project Manager perspective.

Verification is running on server with ID: 1:

Level2: 100% Level3: 0% r

00:00:12 00:00:06 00:00:08 00:00:34 00:00:37 00:00:04 00:00:00

Mormalization: 100% C++Link: 100% Intermediate: 100% Level0: 100% Level1: 100%

1| | 2
@ Full Log | ﬁ Verification Statistics Progress Monitor Cutput Summary|

The progress monitor highlights the current phase in blue and displays the
amount of time and completion percentage for that phase.

The logs report additional information about the progress of the verification.
To view a log, click the button for that log. The information appears in the
log display area at the bottom of the Project Manager window. Follow the
next steps to view the logs:

1 Click the Output Summary tab to display compile phase messages and
errors. You can search the log by entering search terms in the Search in
the log box and clicking the left arrows to search backward or the right
arrows to search forward.

2 Click the Verification Statistics tab to display statistics, such as analysis
options, stubbed functions, and the verification checks performed.
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3 Click the Refresh button
progresses.

to update the display as the verification

4 Click the Full Log tab to display messages, errors, and statistics for all

phases of the verification.

Note You can search the logs. In the Search in the log box, enter a
search term and click the left arrows to search backward or the right

arrows to search forward.

Monitoring Progress Using Queue Manager

You monitor the progress of the verification using the Polyspace Queue

Manager (also called the Spooler).

To monitor the verification of Training_Project:

1 Double-click the Polyspace Spooler icon on the desktop.

i)

PolySpace
Spooler

The Polyspace Queue Manager Interface opens.

ﬂ PolySpace Queue Manager Interface - |EI|1|
Operations  Help
D Author Application Results folder CPU Status Date Language
] PolySpace Demo_C C:'\PolySpace\PolySpaceForCandCPP_... [runstr... (completed |14-Dec-2009, ... [C
-5 polyspace |Demo_C_Single_File |C:\PalySpace\PolySpaceForCandCPP_. .., jrunstr... |completed |14-Dec-2009, ... |C
[+H-8 PolySpace |[Demo_C C:'\PolySpace \polyspace_project'results completed |17-Dec-2009, ... [C
username Training_P iC:\PolySpace\polyspace_projectiresults runstr... frunning 06-Jan-2010, ... [CPP
User mode

Connected to Queue Manager localhost
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Tip You can also open the Polyspace Queue Manager Interface by

clicking the Polyspace Queue Manager icon E on the Run-Time Checks
perspective toolbar.

2 Point anywhere in the row for your job (ID 15 in the figure above).

3 Right-click to open the context menu for this verification.

Follow Progress. ..

Wiew Log File, ..

Download Results., ..

Download Resulks And Remove From Quele. .,

Maove Down In Queue

Skop...
Stop And Download Resulks, .,
Stop And Remove From Queue. ..

Remove From Queue. ..

4 Select View log file.

A window opens displaying the last one-hundred lines of the verification.
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B, View Log File |

Generating results in a spreadsheet format in C:\PolySpace\PolySpace AI

Generation complete

R R R R R R AR AR R AR AR R R R R R R

o

*%% Software Safety Analysiszs Level 4 done

o e

iy iyl e vl e R iy R vl YR vl W i vy YR vl YR vl o i vl ol vl YR vy o i vl R ol o v o i ol R vl o e o i ol R ol o ol Ve i ol o ol o ol o o ol R
Ending at: Jun 2%, 2010 14:&:44

User time for pass4: 00:00:04.7 (4.1lreal, 4.1u + 0= (0gc))

Generating remote file
Done
User time for polyspace-cpp: 00:01:55 (115.5real, 115.5u + 0= (0.2gc)

L2 2]

*%% End of PolySpace Verifier analysis _J

R -

J | b
Close |

5 Click Close to close the window.
6 Select Follow Progress from the context menu.

The Progress Monitor opens.
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-0l

File Edit Window Help

Mormalization: 100% C++Link: 100% Intermediate: 100% Levell: 100% Levell: 100%
00:00:12 00:00:06 00:00:08 00:00:34 00:00:37

Generation complete

=== Software Safety Analysis Level 4 done

Ending at: Jun 29, 2010 14:6:44
User time for pass4: 00:00:04.7 (4. treal, 4. 1u + 0= (Dgc))

Generating remote file
Done
User time for polyspace-cpps 00:01:55 {115, 5real, 115,50 + 0s (0.2gc))

=== End of PolySpace Verifier analysis
-
I | .

@ Full Log ﬁ Verification Statistics | Qutput Summary |

You can monitor the progress of the verification by watching the progress
bar and viewing the logs at the bottom of the window. The progress monitor
highlights the current phase in blue and displays the amount of time and
completion percentage for that phase.

The logs report additional information about the progress of the verification.
To view a log, click the button for that log. The information appears in the
log display area at the bottom of the Project Manager window. Follow the
next steps to view the logs:
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Click the Output Summary tab to display compile phase messages and
errors. You can search the log by entering search terms in the Search

in the log box and clicking the left arrows to search backward or the
right arrows to search forward.

e (Click the Verification Statistics tab to display statistics, such

as analysis options, stubbed functions, and the verification checks
performed.

¢ (Click the Refresh button

progresses.

to update the display as the verification

¢ (Click the Full Log tab to display messages, errors, and statistics for all
phases of the verification.

Note You can search the logs. In the Search in the log box, enter a
search term and click the left arrows to search backward or the right
arrows to search forward.

7 Select File > Quit to close the progress window.

8 Wait for the verification to finish.

When the verification is complete, the status in the Polyspace Queue
Manager Interface changes from running to completed.

ﬂ PolySpace Queue Manager Interface - |EI|£|
Operations  Help
1D Author Application Results folder CPU Status Date Language

----- 4 PolySpace [Demo_C Ci\PolySpace\PolySpaceForCandCPP_.. runstr... [completed |14-Dec-2009, ...

----- 5 polyspace [Demo_C_Single_File |C:\PaolySpace \PaolySpaceForCandCPP_.. runstr... jcompleted |14-Dec-2008, ...

[H-& PolySpace [Demo_C C:\PolySpace\polyspace_projectiresults completed |17-Dec-2008, ...

username [Training_Project  |C:\PolySpace\polyspace_projectiresults runstr... jcompleted |06-Jan-2010, ...

Connected to Queue Manager localhost User mode

3-17



3 Running a Verification

Removing Verification Results from the Server

At the end of a server verification, the server automatically downloads
verification results to the results folder specified in the project. You do not
need to manually download your results.

Note You can manually download verification results to another location on
your client system, or to other client systems.

Verification results remain on the server until you remove them. Once your
results have been downloaded to the client, you can remove them from the
server queue.

To remove your results from the server:

1 In the Polyspace Queue Manager Interface, right-click the verification,
and select Remove From Queue.

A dialog box opens to confirm that you want to remove the verification
from the queue.

Question =

Do wou really want to removwe the analvsis 1 From the queue ?

Yes Mo |

2 Click Yes.

Note To download the results and remove the verification from the queue,
right-click the verification and select Download Results And Remove
From Queue. If you download results before the verification is complete,
you get partial results and the verification continues.

3 Select Operations > Exit to close the Polyspace Queue Manager Interface.
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Once the results are on your client, you can review them using the Run-Time
Checks perspective. You review the results from the verification in Chapter
4, “Reviewing Verification Results”.

Troubleshooting a Failed Verification

When you see a message that the verification failed, it indicates that
Polyspace software could not perform the verification. The following sections
present some possible reasons for a failed verification.

Hardware Does Not Meet Requirements

The verification fails if your computer does not have the minimal hardware
requirements. For information about the hardware requirements, see

www.mathworks.com/products/polyspaceclientc/requirements.html.

To determine if this is the cause of the failed verification, search the log for
the message:

Errors found when verifying host configuration.
You can:

e Upgrade your computer to meet the minimal requirements.

¢ Select the Continue with current configuration option in the General
section of the Analysis options and run the verification again.

You Did Not Specify the Location of Included Files

If you see a message in the log, such as the following, either the files are
missing or you did not specify the location of included files.

include.h: No such file or folder

For information on how to specify the location of include files, see “Creating a
New Project to Verify a Class in the Training C++ File” on page 2-7.
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Tools Menu |

ma Polyspace Preferences x|

Review statuses | Assistant configuration I Miscellaneous I Character encoding

Polyspace Software Cannot Find the Server
If you see the following message in the log, Polyspace software cannot find
the server.

Error: Unknown host

Polyspace software uses information in the preferences to locate the server.
To find the server information in the preferences:

1 Select Edit > Preferences.

2 Select the Remote Launcher tab.

Server configuration | Resllts folder | editors | Generic targets

~Remote configuration

MNote: Send to PolySpace server option is mandatory when the project contains multitasking options.

The multitasking options will be ignored otherwise.

" Automatically detect the remote server

{+ Use the following server and port:  localhost 12427

The server name Tocalhost™ can be used if the server is the local machine.

By default, Polyspace software automatically finds the server. You can
specify the server by selecting Use the following server and port and
providing the server name and port. For information about setting up a
server, see the Polyspace Installation Guide.
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Using Polyspace In One Click to Launch Verification

In this section...

“Overview of Polyspace In One Click” on page 3-21
“Setting the Active Project” on page 3-21

“Sending the Files to Polyspace Software” on page 3-23

Overview of Polyspace In One Click

In a Microsoft Windows environment, Polyspace software provides a
convenient way to streamline your work when you want to verify several
files using the same set of options. Once you have set up a project file that
has the options that you want, you designate that project as the active project,
and then send the source files to Polyspace software for verification. You do
not have to update the project with source file information. This process is
called Polyspace In One Click.

In this part of the tutorial, using Polyspace In One Click, you learn how to:
1 Set the active project.
2 Send files to Polyspace software for verification.

Setting the Active Project

The active project is the project that Polyspace In One Click uses to verify the
files that you select. Once you have set an active project, it remains active
until you change the active project. Polyspace software uses the analysis
options from the project; it does not use the source files or results folder from

the project.
To set the active project:

1 Right-click the Polyspace In One Click icon in the taskbar area of your
Windows desktop:
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The context menu appears.

Set active project k
Open active project - Training_Project

PolySpace - Results View
PolySpace - Project View

£ &1

Spooler

Help 3

Exit

2 Select Set active project > Browse from the menu.

The Please set an active project dialog box appears:

2|
Look in: I&)pofyspacegmjed j [ =5 EE-

ICindudes

mathworks
-
o 2
My Computer
File name: ITlElining_Project «ofg j
Files of type: I PolySpace configuration files j

It

3 In Look in, navigate to polyspace_project.
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4 Select Training_ Project.cfg.

5 Click Open to apply the changes and close the dialog box.

Sending the Files to Polyspace Software

You can send several files to Polyspace software for verification. For this
tutorial, you send one file, training.cpp.

To send training.cpp to Polyspace software for verification:
1 Navigate to the folder polyspace_project\sources.
2 Right-click the file training.cpp.

The context menu appears.

Mame = |
Open
Edit
Cpen with WaordPad
ca Scan for viruses. .,

& I7Arc 3

Open With »
&3 WinZip 2

Send To »

Cut
Copy

Create Shartcut
Delzte
Rename

Properties

3 Select Send To > Polyspace.
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Marne

| Size | Tvpe

Elsining.coc |
Open
Edit
Cpen with WordPad

ca Scan for viruses. .,
Open iith 3

&5 WinZip 2

S5KB CPP File

Send To

Cuk
Copy

Create Shorkout
Delete
Renarme

Properties

[£] Compressed (zipped) Folder
[@ Desktop (create shortout)
[ Fax Destination wvia RightFa

i# Macromedia FreeHand M3
| Mail Recipient

_D My Dacurments

PolySpace

L 314 Floppy (A1)

The Polyspace basic settings dialog box appears.




Using Polyspace® In One Click to Launch Verification

PolySpace basic settings [ C++ ] - |E||5|

Settings

Precision |02

Passes [Pass2 (Saftware Safety Analysis level 2)

Results folder |C:"'-.F‘Dh'Spac:e"-ponspace _project

Verification Mode Settings

¥ Generate main automatically " Use existing main

Class II'\"IaththiIs

Class analyzer calls Iunused

Class only [l

Main generator write variables IUninit

Main generator calls IUnused

Function called before main |

Scope

C\PolySpace\polyspace_project‘sourcestraining .cpp

[1]+

vl Send to PolySpace Server D) St,artl @Cannel |

4 Make sure that Results folder is polyspace project\results.

5 The Verification Mode Settings are inherited from the active project
(Training_Project.cfg). For this tutorial, you are verifying a single class

3-25



3 Running a Verification

3-26

(MathUtils), which you already configured in the project. Therefore, you do

not need to modify these parameters.

Note The Class only checkbox is selected by default. This activates the
-class-only option in Polyspace. For the purposes of this tutorial, it
does not matter whether or not this option is applied because the class

MathUtils does not depend on any other classes.

6 Select the Send to Polyspace Server option if it is not already selected.

7 Leave the default values for the other parameters.

8 Click Start.

The verification log appears.

C:‘._PolySpace\pnlvspace_pmject\rﬂlts _|EI|£|
E & @ -

MWumber of lines with libraries : 7833 ﬂ
Packing compilation datas

done.

Generating remote file

Done

ik

% ++ gource cempliance checking done
p—

Ending at: Jan &6, 2010 14:3:13
User time for compilation: 00:00:04.54 (4 5real, 4.5u + 0= (0.1gc))
User time for polyspace-cpp: 00:00:04.75 (4.2real, 4.8u + 0= (0.1gc))

ik

***End of PolySpace Verifier analysis

o

Adding the verification to the queus...
Queue Manager zerver: localhost

Transfer completed.
Analysiz D16
The verification has been queued. You may follow itz progress using the Queus Manager -

|
| | »

|The code verfication completed successfully I

The compile phase of the verification runs on the client. When the compile

phase completes:
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You see the following message in the log:
End of Polyspace Verifier analysis

A message in the log tells you that the verification was transferred to the
server queue and gives you the identification number (Analysis ID) for the
verification. For this verification, the identification number is 1.

Monitor the verification using the Spooler. For information on using the
Spooler to monitor a verification on a server, see “Monitoring Progress
Using Queue Manager” on page 3-13.

When the verification completes, download the results to

polyspace _project\results. For information on downloading results
from a server to a client, see “Removing Verification Results from the
Server” on page 3-18

You review the results in Chapter 4, “Reviewing Verification Results”.
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Launching Client Verification from Project Manager

In this section...

“Starting the Verification” on page 3-28
“Monitoring the Progress of the Verification” on page 3-30
“Completing the Verification” on page 3-31

“Stopping the Verification Before It Completes” on page 3-32

Starting the Verification

For the best performance, run verifications on a server. If the server is busy
or you want to verify a small file, you can run a verification on a client.

Note Because a verification on a client can process only a limited number
of variable assignments and function calls, the source code should have no
more than 800 lines of code.

To start a verification that runs on a client:

1 If the project Training Project.cfg is not already open, open the project.

For information about opening a project file, see “Opening the Project”
on page 3-4.

2 Clear the Send to Polyspace Server check box in the General Analysis
options.
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Mame Value Internal name

Analysis options

El-General

----- Send to PolySpace Server

..... Add to results repository -add-to-results-repository

Vv -SErver
B

----- Keep all preliminary results files r +eep-all-files
r
I

----- Calculate code metrics

-code-metrics

[=-Repart Generation
----- Report template name Z:'Polyspacef ... |-report-template
----- Cutput format RTF - report-output-format

3 If you see a warning that multitasking is not available when you run
a verification on the client, click OK to continue and close the message

box. This warning only appears when you clear the Send to Polyspace
Server check box.

4 (Click the Run button M on the Project Manager toolbar.

The progress bar and logs area of the Launcher window become active.

Note If you see the message Verification process failed, click OK
and go to “Troubleshooting a Failed Verification” on page 3-19.
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Monitoring the Progress of the Verification

You can monitor the progress of the verification by watching the progress bar
and viewing the logs at the bottom of the Launcher window.

Verification is running

Compile: 100% Mormalization: 100% C++Link: 100% Intermediate: 100% LevelD: s | Levell: 0% Level2 : 0% |
00:00:10 00:00:17 00:00:23 00:00:19 00:00: 39 00:00:00 00:00:00

1| | i
@ Full Log | ﬁ Verification Statistics Progress Monitor Qutput Summary|

The progress bar highlights the current phase in blue and displays the
amount of time and completion percentage for that phase.

The logs report additional information about the progress of the verification.
To view a log, click the button for that log. The information appears in the
log display area at the bottom of the Project Manager window. Follow the
next steps to view the logs:

1 Click the Output Summary tab to display compile phase messages and
errors. You can search the log by entering search terms in the Search in
the log box and clicking the left arrows to search backward or the right
arrows to search forward.

2 Click the Verification Statistics tab to display statistics, such as analysis
options, stubbed functions, and the verification checks performed.

3 Click the Refresh button to update the display as verification runs.

4 Click the Full Log tab to display messages, errors, and statistics for all
phases of the verification.

Note You can search the logs. In the Search in the log box, enter a
search term and click the arrows to search backward or forward.
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Completing the Verification

When the verification is complete, the message “Verification Completed”
appears at the bottom of the Project Manager window, and the results appear
in the Project Browser.

" Project Browser

AR | r ¥ E
=-{=] Training_Project [C++]
B} Source
--Jf—_"u sources
B Indude
533 ... Ninclude-gnu
-3 ... \indude-gnunext
5 .. Nincudes
17 Verification_(1)
EIE‘,.! Source
F1ES) sources
El-F= Configuration
@Training_iject
-
--ﬁ Result_(1) [Verification Completed]
--ﬁ Result_{2)
E}E‘ Result_(3) [Verification Completed]

-@ options

----- [ RTE_px_Training_Project_LAST_RESULTS.rte

In the tutorial Chapter 4, “Reviewing Verification Results”, you open the
Run-Time Checks perspective and review the verification results.
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Stopping the Verification Before It Completes

You can stop the verification before it is complete. If you stop the verification,
results are incomplete. If you start another verification, the verification starts
over from the beginning.

To stop a verification:

5t
1 Click the Stop button M on the Project Manager toolbar.

A warning dialog box opens.

waming x|

@ Do wou really want to stop the current execution ?

o |

2 Click Yes.

The verification stops and the message Verification process stopped
appears.

3 Click OK to close the Message dialog box.

Note Closing the Polyspace verification environment window does not stop
the verification. To resume display of the verification progress, start the
Polyspace software and open the project.
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Results

* “About Reviewing Verification Results Tutorial” on page 4-2
® “Opening Verification Results” on page 4-3

¢ “Exploring the Viewer Window” on page 4-4

* “Reviewing Results in Manual Mode” on page 4-9

® “Reviewing Results in Assistant Mode” on page 4-24

® “Generating Reports of Verification Results” on page 4-31
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About Reviewing Verification Results Tutorial

In this section...

“Overview” on page 4-2

“Before You Start” on page 4-2

Overview

In the previous tutorial, Chapter 3, “Running a Verification” , you completed a
verification of the class MathUtils in the file training.cpp. In this tutorial,
you explore the verification results.

The Polyspace verification environment contains a Run-Time Checks
perspective that you use to review results. In this tutorial, you learn:
1 How to use the Run-Time Checks perspective, including how to:
® Open the Run-Time Checks perspective and view verification results.
e Explore results in expert mode.
® Explore results in assistant mode.

® Generate reports.

2 How to interpret the color-coding that Polyspace software uses to identify
the severity of an error.

3 How to find the location of an error in the source code.

Before You Start

Before starting this tutorial, complete the tutorial Chapter 3, “Running a
Verification”. In this tutorial, you use the verification results stored in this
file:

polyspace_project\Verification_(1)\Result_(1)\
RTE_px_Training_Project_LAST_RESULTS.rte.
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Opening Verification Results

In this section...

“Opening Run-Time Checks Perspective” on page 4-3

“Opening Verification Results” on page 4-3

Opening Run-Time Checks Perspective

You use the Run-Time Checks perspective to review verification results.

To open the Run-Time Checks perspective:

. <L Run-Time Checks |
e Select the Run Time Checks button in the Polyspace

Verification Environment toolbar.

Opening Verification Results
To open the verification results:

1 Select File > Open Result.
The Please select a file dialog box opens.
2 Navigate to the results folder:
polyspace_project\Verification_(1)\Result_(1).
3 Select the file RTE_px_Training_Project_LAST_RESULTS.rte.
4 Click Open.

The results appear in the Run-Time Checks perspective.

Note You can also open results from the Project Manager perspective by
double-clicking the results file in the Project Browser.
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Exploring the Viewer Window

In this section...

“Overview” on page 4-4

“Reviewing Run-Time Checks Pane” on page 4-7

Overview
The Run-Time Checks perspective looks like the following figure.
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Review Details

Review Statistics

| =lolx|
File Edit Run Review Options Window Help
T ™ | | & BB | % LI P2ye 2 | | |} Project Manager |- Coding Rules | % Run-Time Checks
leview Statistics. aR
RIYE | ’_7 | 317 | :_7 | i d § i]lli Coding review progress Count |Progress
" - - - Red NTC justified [ to justify 0f1 [i]
i training. MathLtils: :Recursion_caller(} /line 124 / column 13
Procedural entities 1 <P/ el / Red justified / to justify 02 0
|25 Training_Froject z Recursion( sx ); // elways encounters & division by zero Gray justified / to justify o/1 0
[)-training.h 2| 1 |00 . y | |Orange justified / to justify 1ja 18
[#]-exception stdh 1|0 [Classification Status Justified  Comment - |Software reliability indicator 79/88 89
5 o High ;"F\x LI r Ile Mow i
B e the ning.MathUtils: :Recursion(int*} call never terminates
El - 51| 1|9 |funreachable check : call to Recursion does not throw
4| 12| s
3| 39 |00
1]E] et |os - Check Details |-§'- Expanded Sourc.. | @ Review Statistics
2| 8| 10480 -
e s 1 | 4 B
o | 197|100 aining.cpp | _polyspace_main.cpp |
-
w
| s 3
120 | 116 - B pst_stubs_Utils: random_int]}
123 117 void MathUrils::Recursion caller () B pst_stubs Utis: ransom_int])
123 118 ! B training. MathUtils:: Recursion{int]
124 12 If“"lls ur . B pst_stubs_ Utils: random_int]}
124 120 int x=u.rendon_inc(); B training MathUtils:: Recursion(int")
1z1
z o | s02_main main
= 122 %= -4; polysp
= 123 if {u.ramdom_int(} > O}
28 124 Recursion( &x }: /¢ always encounters a division by zero
- RTE: test]) e o | 125 J e s
- Saquare::Square_F|ot)) Rl BE: ® = 10: Variables |2 Reld]2 wre| Wt [RT [Line|
- Square::Square_F|ot_conv(# wolo |f1z7 if {uw.random_int(} > 0) Traiming_Proct
- Square::Unreachs|ile_Coda() 184| 0 1z8 Recursion( &x )} // never encounters a diwvision by zero
[~ polyspace_stdstut|.c vlo [f1zs + ol
[#]-_polyspscs_stdstutficpn.cpp 1|0 130
I 1 [100]ff 131
132
4| | >| . P ﬂ
133 /% Hara wa demonatifate PoluSnacs Warifier!s ahilits tn trace n
- Run-Time Checks | - Assistant Chedks | 4 i Hf L | i
[ 0% Training_Project  Source file: _polysp|ce_main.cpp  _polyspace_main.cpp  Line:1  Column: unknwn
Run-Time Source Variable Call
Checks code Access Hierarchy

The Run-Time Checks perspective has six sections below the toolbar. Each
section provides a different view of the results. The following table describes
these views.

4-5



4 Reviewing Verification Results

4-6

This Pane...

Displays...

Run-Time Checks
(Procedural entities view)

List of the checks (diagnostics) for
each file and function in the project

Source
(Source code view)

Source code for a selected check in
the procedural entities view

Review Statistics
(Coding review progress view)

Statistics about the review progress
for checks with the same type and
category as the selected check

Review Details
(Selected check view)

Details about the selected check

Variable Access
(Variables view )

Information about global variables
declared in the source code

Call Hierarchy
(Call tree view)

Tree structure of function calls

You can resize or hide any of these sections. You learn more about the

Run-Time Checks perspective later in this tutorial.
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Reviewing Run-Time Checks Pane

The Run-Time Checks pane displays a table with information about the
diagnostics for each file in the project. The Run-Time Checks pane is also
called the Procedural entities view

When you first open the results file from the verification of training.cpp, the
Run-Time Checks pane looks like this.

F| % || O
Procedural entities 1 1M #|-+|Line| =
3E T8 33
i]-training.h 2| 1 |10
--ax:eptk:ur.at-:l‘ L
---r=_f.1.'.5t-:|' |0
---51_.r5rra=r{:-5.|' LI
---I's ning. cpp p: T 23
---_p:-h_.rapa:ba_at-: stubs.c 1|0
---_p:-h,rapa:ba_at-: stubscpp.cp 1 4]
---_: olyspace_main. cpp T 1 (10D

The file training.cpp is red because its contains a run-time error. Polyspace
software assigns each file the color of the most severe error found in that file.
The first column of the table in the Procedural Entities View is the procedural
entity (the file or function). The following table describes some of the other
columns in the procedural entities view.
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Column
Heading

Indicates

Number of red checks (operations where an error always
occurs)

Number of gray checks (unreachable code)

Number of orange checks (warnings for operations where
an error might occur)

Number of green checks (operations where an error never
occurs)

e | | | 1|1

Selectivity of the verification (percentage of checks that are
not orange)
This is an indication of the level of proof.

Note You can select which columns appear in the procedural entities view
by editing the preferences.

What you select in the procedural entities view determines what displays in
the other views. In the following examples, you learn how to use the views
and how they interact.
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Reviewing Results in Manual Mode

In this section...
“What Is Manual Mode?” on page 4-9

“Switching to Manual Mode” on page 4-9
“Reviewing Checks in Manual Mode” on page 4-9
“Reviewing Additional Examples of Checks” on page 4-15

“Filtering Checks ” on page 4-19

What Is Manual Mode?

In manual mode, you see all checks in the Run-Time Checks perspective. You
decide which checks to review and in what order to review them.

Switching to Manual Mode

By default, the Run-Time Checks perspective opens in assistant mode. To
switch from assistant to manual mode:

e Move the Assistant slider to Off in the Run-Time Checks toolbar.

l—

ofr 1 2 3

The toolbar displays buttons and menus specific to expert mode.

Reviewing Checks in Manual Mode
In this part of the tutorial, you learn how to use the Run-Time Checks

perspective to examine verification checks. This part of the tutorial covers:
e “Selecting a Check to Review” on page 4-10
* “Displaying the Calling Sequence” on page 4-11

* “Tracking Review Progress” on page 4-12
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Selecting a Check to Review

In the procedural entities view, training.cpp is red, indicating that this file
has at least one red check.

To review a red check in training.cpp:

1 In the procedural entities section of the Run-Time Checks pane, expand
training.cpp.

2 Expand the red procedure MathUtils::Pointer_ Arithmetic().

A color-coded list of the checks performed on
MathUtils::Pointer_Arithmetic() appears:

Each item in the list of checks has an acronym that identifies the type
of check and a number. For example, in IDP.9, IDP stands for Illegal
Dereferenced Pointer.

For more information about different types of checks, see “Check
Descriptions” in the Polyspace Products for C++ Reference.

3 Click on the red IDP.9.

The Source pane displays the section of source code where this error occurs.
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(= TSeurce g A

K

training. cpp 1 B
[

[ int tab[l00];

1 int i, *p = tab;

a7

6 forii 0; i< 100; it++, p++)

63 0: [

70

71 if(u. randow inti) == 0]

72 N Jf tut of bounds

73

T4 i = u.random int():

75 if (u.random int(j) fp-i) = 10;

76

77 if (01 &g i<=100)

78

4 At line 72 of the code, click on the red code.

An error message box appears indicating that when the pointer p is
dereferenced, it is outside of its bounds. At line 66, p points to the start of
tab which has 100 elements. The for loop starting at line 68 initializes
the elements of tab to 0. This for loop leaves p pointing to the location
after the last element of tab.

Displaying the Calling Sequence
You can display the calling sequence that leads to the code associated

with a check. To see the calling sequence for the red IDP.9 check in
MathUtils::Pointer_Arithmetic():

1 Expand MathUtils::Pointer_ Arithmetic().

2 Click the red IDP.9.

E
3 Click the call graph button ‘3‘ in the Review Details toolbar.

A window displays the call graph.
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=) -|'_::|. 100% - )'. +

Training_F‘rnj...hmeh’c[).IDP.El] 1 F B

_polyspace_main.cpp training.cpp training.cpp
main MathUtls: :Pointer _Arithmetic() IDP.9

The code associated with IDP.9 is in MathUtils::Pointer_ Arithmetic.
The generated main function calls MathUtils: :Pointer_ Arithmetic.

Tracking Review Progress

You can keep track of the checks that you have reviewed by marking
them. To mark that you have reviewed the red IDP.9 check in
MathUtils::Pointer_Arithmetic():

1 Expand MathUtils::Pointer_Arithmetic().

2 Click the red IDP.9.

The Review Statistics pane displays a table with statistics about the review
progress for that category and severity of error.
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Coding review progress Count | Progress
{Fed IDP justified / to justify 0,1 0
[Red justified | to justify 02 0
Gray justified [ to justify 0f1 ]
Orange justified [ to justify 0/fa 0
Software reliability indicator 7a/38 a9

< Check Detailz |'—fl Expanded Sourc.. lﬁ Review Statistics

The Count column displays a ratio and the Progress column displays
the equivalent percentage.

The first row displays the ratio of reviewed checks to the total number of
checks that have the same color and category as the current check. In this
example, it displays the ratio of reviewed red IDP checks to total red IDP
errors in the project.

The second row displays the ratio of reviewed checks to total checks that
have the same color as the current check. In this example, this is the ratio
of red errors reviewed to total red errors in the project.

The last row displays the ratio of the number of green checks to the total
number of checks, providing an indicator of the reliability of the software.

Information about the current check (the red IDP.9) appears in the
upper-right part of the Viewer window.
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5 1

training.cpp / MathUtils: :Pointer_Arithmetic() /line 72 / column 4
*p = 5; f/ Out of bounds
Classification Status Justified Comment
High L"Fix ;I ¥ IFix Mow

rror @ polnter is outside its bounds
dereference of varieble 'p'" (pointer to int 32, size: 32 bits):
pointer is not null
points to 4 bytes at offset 400 in buffer of 400 bytes, 30 is outside bounds
may polnt to variable or field of wariable in: {MathUtils::Pointer Rrithmetic():tab}

3 After you review the check, select a Classification to describe the
seriousness of the issue:

® High
® Medium
® |ow

® Not a defect

4 Select a Status to describe how you intend to address the issue:
® Fix
* Improve
® Investigate
® Justify with annotations
® No Action Planned
® Other
® Restart with different options

® Undecided
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Note You can also define your own acronyms. See “Defining Custom
Status ”.

5 In the comment box, enter additional information about the check.
6 Select the check box to indicate that you have justified this check.

The Coding review progress part of the window updates the ratios of
errors reviewed to total errors.

Coding review progress Count | Progress
IREd IDP justified [ to justify 1/1 100
(Red justified [ to justify 12 50
Gray justified [ to justify af1 i
Crange justified [ to justify 0fa i}
Software reliability indicator 7938 39

~ Check Details |-9- Expanded Sourc.. l 5B review Staﬁsh'u:s]

Reviewing Additional Examples of Checks
In this part of the tutorial, you learn about other types and categories of

errors by reviewing the following examples in training.cpp:
¢ “Example: Unreachable Code” on page 4-15
e “Example: A Function with No Errors” on page 4-17

e “Example: Division by Zero” on page 4-18

Example: Unreachable Code

Unreachable code is code that never executes. Polyspace software displays
unreachable code in gray. In the following steps, you will look at an example
of unreachable code.
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1 In Procedural Entities, click on Square: :Unreachable Code().

The source code for this function displays in the source code view.

training. cpp 4 B
[

160 /% Here we demonstrate Polvyipace Verifier's ability to

161 identify unreachable sections of code due to the

162 wvalue constraints placed on the wariables.

163 S

164 wold Square::Unreachable Codef)

1la45 1

166 Teils u;

167 int ¥ = u.random int():

168 int ¥ = u.random_int();

155

170 if (x> w)

171 1

172 X=X - ¥

173 if (x < 0)

174 X =X+ 1:

175 B J

176

177 X o= ¥

175 3 -

H | 3

2 Examine the source code.

At line 174, the code x = x +1 is never reached because the condition x

< 0 is always false.

Note In the Procedural Entities view all public and protected member
functions for the classes RTE and Square are marked as unreachable code.
This is because the analysis results are from the single class verification of

MathUtils which does not depend on any other classes.




Reviewing Results in Manual Mode

Example: A Function with No Errors

In the following example, Polyspace software determines, in code with a large
number of iterations, that a loop terminates and a variable does not overflow:

1 In Procedural entities, click on the green
MathUtils::Non_Infinite Loop() function.

The source code for this function is displayed in the source code view.

“TSowce AR

training.cpp 1 F B
34 Carrect operation iz demomonstrated bhecausze: ;I
35 1) ®» = ®x + 2 iz shown to never generate an owerflow

36 21 the loop is not infinite

37 */
38 J
39

40 i

41 const int big = 1073741821 ; 4/ 2%*%30-3
42 int x=0, ¥=0;

43

44 while (1 == 1)

45 {

46 if (¥ > biyg) break;
47 xo=xt2;

45 ¥ o=/ 2;

49 1

L0

£l ¥ =x / 100;

L2 Eeturn ¥;

53 K hal
b | 5

2 Examine the source code. The variable x never overflows because the while
loop at line 44 terminates before x can overflow.
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Example: Division by Zero

In the following example, Polyspace software detects a potential division
by zero:

1 In Procedural entities, expand MathUtils: :Recursion().

The source code for this function is displayed in the source code view.

training. cpp 4 B

93 If the initial walue passed to Becursioni() is negatiwve, then;I
94 the recursive loop will at some point attempt a division

a5 by zero.

a5 L

a7

a5 void MathlUtila: iRecursion 2(int* depth)

] 1

100 Fecursion (depth);

101 1

10z

103 S* 1if depth<0, recursion will lead to division by zero +/
104 woid MathUltils: :Recursion (int* depth)

105 1

106 float adwance:

1a7

10s #depth = *depth + 1;

109 advance 1.0/ifloat) (*depch); J/ potential division by zero
110

111 if (Fdepth < 50

11z !

113 Recursion_zZidepth) ;

114 1

115 1 =
< | 3

2 Examine the MathUtils: :Recursion() function.

When Recursion() is called with depth less than zero, the code at line
109 will result in division by zero. The orange color indicates that this is a
potential error (depending on the value of depth).
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Filtering Checks

You can filter the checks that you see in the Run-Time Checks perspective so
that you can focus on certain checks. Polyspace software allows you to filter
your results in several ways. You can filter by:

® Check category (ZDV, IDP, NIP, etc.)

Color of check (gray, orange, green)

Justified or unjustified

Classification

Status

To filter checks, select one of the filter buttons in the Run-Time checks toolbar.

Tip The tooltip for a filter button describes what filter the button activates.

Example: Filtering NIVL Checks

You can use an RTE filter to hide a given check category, such as NIVL. When
a filter is enabled, you do not see that check category.

To filter NIVL checks:

1 Expand MathUtils::Close_To_Zero().

Square_Root()has 16 checks: 13 are green, and three are orange.

4-19



4 Reviewing Verification Results

<<

8 5 8
ra

<<

4

(]
T

r

=

RTE
2 Click the RTE filter icon ﬂ.

3 Clear the NIVL option.

= Chedks
| b | | B |
Display Al
Hide Al
B OBal
M oV
M ., MIVL
M s-OvFL
M sHF
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The software hides the NIVL checks for MathUtils::Close To Zero().

B

4 Select the NIVL option to redisplay the NIVL checks.

Note When you filter a check category, some red checks within that category
are still displayed. For example, if you filter IDP checks, IDP.9 is still
displayed under MathUtils::Pointer_Arithmetic().
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Example: Filtering Green Checks

You can use a Color filter to hide certain color checks. When a filter is
enabled, you do not see that color check.

To filter green checks:

1 Expand MathUtils::Close _To_Zero().

Square_Root()has 16 checks: 13 are green, and three are orange.

&

+
2 Click the Color filter icon ﬂ

3 Clear the Green Checks option.
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“ Run-Time Chedks ® | Review Detai
E

| ||| % I

Pl M Gray Checks

ﬁ M Orange Checks
[?]--ex &

Green Checks |
E b \%rmrs in non executable procedures

£ M orange checks possibly impacted by inputs

The software hides the green checks.

[N R ) Ll
T
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Reviewing Results in Assistant Mode

In this section...

“What Is Assistant Mode?” on page 4-24

“Switching to Assistant Mode” on page 4-24

“Selecting the Methodology and Criterion Level” on page 4-25
“Exploring Methodology for C++” on page 4-25

“Reviewing Checks” on page 4-27

“Defining a Custom Methodology” on page 4-29

What Is Assistant Mode?

By default, the Run-Time Checks perspective opens in assistant mode. In
assistant mode, Polyspace software chooses the checks for you to review and
the order in which you review them. Polyspace software presents checks

in this order:

1 All red checks.
2 All blocks of gray checks (the first check in each unreachable function).
3 Orange checks according to the methodology and criterion level you select.

You will learn about methodologies and criterion levels in “Selecting the
Methodology and Criterion Level” on page 4-25.

Switching to Assistant Mode

To switch from expert to assistant mode:

e Move the Assistant slider to 1 in the Run-Time Checks toolbar.

—_——

or 1 2 3

The Assistant Checks tab opens, displaying the checks you need to review,
and the toolbar displays controls specific to assistant mode.
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I B x| B 4 > M e

o 1 2 3 [|Methodology for C++

The controls for assistant mode include:

® A menu for selecting the review methodology for orange checks.
e A slider for selecting the criterion level within that methodology.

® Arrows for navigating through the reviews.

Selecting the Methodology and Criterion Level

A methodology defines which orange checks you review in assistant mode.
Each methodology has three criterion levels, corresponding to different
development phases, with increasing review requirements. As the criterion
level increases, you review more checks.

To select the methodology and level for this tutorial:

1 Select Methodology for C++ from the methodology menu.

Methodology for C++ LI

Methodeology for C

Methodology for G+
Methodology for Model-Based Design
My Custom Set

2 If the level slider is not already at 1, move the slider to level 1.

l—l_

of 1 2 3

Exploring Methodology for C++
In this part of the tutorial, you examine Methodology for C, which defines
the number of orange checks you review in assistant mode.

To examine the configuration for Methodology for C:

1 Select Options > Preferences.

4-25



4 Reviewing Verification Results

4-26

The Polyspace Preferences dialog box opens.
2 Select the Assistant configuration tab.
The configuration for Methodology for C++ appears.

On the right side of the dialog box, a table shows the number of orange
checks that you review for a given criterion and check category.

E.ﬁ.ssismnt configuration Character encoding

—Murnber of chedks to review
Criterion 1 Criterion 2 Criterion 3
—Camman
DV 5 20 ALL
MIVL 10 50 ALL
S-OVFL 10 50 ALL
COR 10 10
NIV 5 10
F-OVFL 5 10 20
ASRT 5 20
—C B C++only
CBAI 10 20 ALL
SHF 5 10 ALL
& IoP 10 20
MIP 10 20

For example, the table specifies that you review five orange ZDV checks

when you select criterion 1. The number of checks increases as you move
from criterion 1 to criterion 3, reflecting the changing review requirements
as you move through the development process.

In the lower-left part of the dialog box, the section Review threshold
criterion contains text that appears in the tooltip for the criterion slider
on the Run-Time Checks toolbar.
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—Configuration set

IMEﬁ'lEIdDbgy' for C++ ;I

r Set number of checks to review as percentage
of green and justified orange checdks

—Review threshold criterion

Criterion 1 Fresh code
Criterion 2 Unit tested
Criterion 3 Final version

For the configuration Methodology for C++, the criterion names are:

Criterion Name in the Tooltip
1 Fresh code

2 Unit tested

3 Final version

These names correspond to phases of the development process.

3 Click OK to close the dialog box.

Reviewing Checks

In assistant mode, you review checks in the order in which Polyspace software
presents them:

e All of the red checks.

e All blocks of gray checks (the first check in each unreachable function).

® Orange checks according to the selected methodology and criterion level.
Earlier in this tutorial, you selected Methodology for C++, criterion 1. In this

part of the tutorial, you continue to review the checks for training.cpp using
this methodology and criterion level. To navigate through these checks:
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1 Click the forward arrow J

The Assistant Checks tab shows the current check (IDP.9).

training. MathUtils:
training. MathUtils:

Chedk

:Pointer_Arithmetic().IDP. 9
:Reecursion_caller().NTC.5

training. MathUtils:

:Recursion_caller().EXC.6

training. MathUtils:

:Recursion(int™®).ZDV.9

training. MathUtils:

:Recursion{int®). OVFL. 7

training, MathLtils;

iClose_To_Fero(),OVFL.&

training, MathLtils;

iClose_To_Fero(),OVFL. 10

VARSI R A
b e e e

training. MathLtils:

iClose_To_Zero().OVFL, 12

S Run-Time Chedks I S Assistant Chen:ksJ

The source code view (lower right) displays the source for this check and
the current check view (upper right) displays information about this check.

Note You can display the calling sequence and track review progress as
described in “Reviewing Results in Manual Mode” on page 4-9.

2 Continue to click the forward arrow until you have gone through all of

the checks.

After the last check, a dialog box appears asking if you want to start again

from the first check.
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Wrapping search ]|

@ End of the set of checks under review,
Do wiou wank bo skark again From the First check?

3 Click No.

Defining a Custom Methodology

You cannot change the predefined methodologies, such as Methodology for
C++, but you can define your own methodology. In this part of the tutorial,
you learn how to create and use your own methodology.

To define your custom methodology:

1 Select Options > Preferences.
The Polyspace Preferences dialog box opens.
2 Select the Assistant configuration tab.
3 Select Add a set from the Configuration set menu.

4 In the Create a new set dialog box, enter My methodology for the name and
click Enter to close the dialog box.

5 Under the Criterion 1 column, enter the number 1 next to IDP. Polyspace
software selects up to one orange IDP for review.

The software will not select any other orange checks for review because you
are leaving all of the other fields blank. This does not affect the red and
gray checks. The software will still present all red checks and the first
check in each unreachable function for review.

6 Click OK to save the methodology and close the dialog box.

To use My methodology:
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1 Select My methodology from the methodology menu.

2 If the level slider is not already at 1, move the slider to level 1.

]
3 Click the forward arrow J to review the checks.

With this methodology at criterion 1, you review the orange IDP.3 check.
You did not review IDP.3 earlier in the tutorial because the number of
orange IDP checks in Methodology for C++ criterion level 1 is zero.
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Generating Reports of Verification Results

In this section...

“Polyspace Report Generator Overview” on page 4-31

“Generating Verification Reports” on page 4-32

Polyspace Report Generator Overview

The Polyspace Report Generator allows you to generate reports about your
verification results, using pre-defined report templates.

The Polyspace Report Generator provides the following report templates:

Coding Rules Report — Provides information about compliance with
MISRA C® Coding Rules, as well as Polyspace configuration settings for
the verification.

Developer Report — Provides information useful to developers, including
summary results, detailed lists of red, orange, and gray checks, and
Polyspace configuration settings for the verification. Detailed results are
sorted by type of check (Proven Run-Time Violations, Proven Unreachable

Code Branches, Unreachable Functions, and Unproven Run-Time Checks).

Developer Review Report — Provides the same information as the
Developer Report, but reviewed results are sorted by review classification
(High, Medium, Low, Not a defect) and status, and untagged checks are
sorted by file location.

Developer with Green Checks Report — Provides the same content as
the Developer Report, but also includes a detailed list of green checks.

Quality Report — Provides information useful to quality engineers,
including summary results, statistics about the code, graphs showing
distributions of checks per file, and Polyspace configuration settings for
the verification.

Software Quality Objectives Report — Provides comprehensive
information on software quality objectives (SQO), including code metrics,
code analysis (coding-rules checker results), code verification (run-time
checks), and the configuration settings for the verification. The code
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metrics section provides is the same information displayed in the Polyspace
Metrics web interface.

The Polyspace Report Generator allows you to generate verification reports in
the following formats:

e HTML
e PDF
e RTF
e WORD
e XML

Note Microsoft Word format is not available on UNIX platforms. If you select
Word format on a UNIX platform, the software uses RTF format instead.

Generating Verification Reports

You can generate reports for any verification results using the Polyspace
Report Generator.

To generate a verification report:

1 If your verification results are not already open, open them.
2 Select Run > Run Report > Run Report.

The Run Report dialog box opens.
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x

—Select Report Template

C:\PolySpace\PolySpace_Common'\ReportGenerator templates\CodingRules. rpt

C:\PolySpace\PolySpace_Common'\ReportGenerator \templates\Developer.rpt
Ci\PolySpace\PolySpace_Common\ReportGenerator itemplates \DeveloperReview. rpt
C:\PolySpace'\PolySpace_Common'\ReportGeneratoritemplates \Developer_WithGreenChecks.rpt
Ci\PolySpace\PolySpace_Common'\ReportGenerator templates\Quality . rpt

Erowse... |

—Select Report Format

Qutput folder IC:'lFDh.l'SDEIEE'lpDh.-'SpECEJZIFDjECt'I,I’ESUHS'IPIZIHI'SDEIEE-DDE |

Qutput format IPDF vI

Fun Report | Cancel |

3 In the Select Report Template section, select Developer.rpt.

4 In the Output folder section, select the \polyspace_project folder.
5 Select PDF Output format.

6 Click Run Report.

The software creates the specified report.
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Checking Compliance with
Coding Rules

* “About Checking Compliance with Coding Rules Tutorial” on page 5-2
e “Setting Up Coding Rules Checking” on page 5-4
® “Running a Verification with Coding Rules Checking” on page 5-13
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About Checking Compliance with Coding Rules Tutorial

In this section...

“Overview” on page 5-2

“Before You Start” on page 5-3

Overview

Polyspace software allows you to analyze code to demonstrate compliance
with established C++ coding standards (MISRA C++:2008 or JSF++:2005).

Applying coding rules can both reduce the number of orange checks in your
verification results, and improve the quality of your code. Coding rules are
the most efficient way to reduce orange checks.

To check compliance with coding rules, you set an option in your project and
then run a verification. Polyspace software finds the violations during the
compile phase of a verification. When you have addressed all coding rule
violations, you run the verification again.

For more information on the coding rules checker, see “Checking Coding
Rules”in the Polyspace Products for C++ User’s Guide.

In this tutorial, you learn how to:

1 Create a second verification within your project.
2 Set an option for checking JSF++ compliance.

3 Select JSF++ rules to check.

4 Run a verification with JSF++ checking.

5 View coding rules violations using the Coding Rules perspective.
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Before You Start

For this tutorial, you check the JSF++ compliance of the file training.cpp,
using the project that you created in Chapter 2, “Setting Up a Polyspace
Project”.
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Setting Up Coding Rules Checking

In this section...

“Opening Your Project” on page 5-4

“Creating New Verification” on page 5-5

“Setting the JSF++ Checking Option” on page 5-7
“Creating a JSF++ Rules File” on page 5-7
“Excluding Files from JSF++ Checking” on page 5-10
“Configuring Text and XML Editors” on page 5-11

“Saving the Project” on page 5-12

Opening Your Project

For this tutorial, you modify the project in Training Project.cfg to include
JSF++ checking. You use the Project Manager perspective to modify the
project.

To open Training Project.cfg:

1 Select File > Open project.

The Open a Polyspace project file dialog box opens.
2 Navigate to polyspace_project.
3 Select Training Project.cfg.

4 Click Open to open the file and close the dialog box.
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Creating New Verification

A Polyspace project can contain multiple verifications. Each verification may

verify a different set of source files, and may use different analysis options. In
this section, you create a second verification to check coding rules compliance

for the training.cpp file.

To create a new verification in Training Project:

1 In the Project Browser, select Training_Project [C++].

2 Click the Create a new verification icon @ in the upper left the Project
Browser.

A new verification, Verification_ (2), appears in the Project Browser.

FIELIEIEEE

[=-{~) Training_Project [C++]
E}@ Source

[#-1£5) sources

- Incude

{3 ... indude-gnu

{3 v indude-gnutpext

-E3 ... \indudes

B3 Verification_(1)

-3 Source

- sources

=~ Configuration

E Training_Project

=~ Result
"[ﬁ] Result_(1) [Verification Completed]
[#-E3) Result_(2)

Y caton_ (o)

'& Source

E| [ Configuration

: E~----ETrainil'ug_F‘rDject

L{3) Result
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3 In the Project Browser Source tree, right-click training.cpp, and select
Copy Source File to > Verification_(2).

The training.cpp file appears in the Source tree of Verification (2).

4 Right-click the Configuration folder in Verification_(2), and select Create
New Configuration.

The Project Browser now looks like the following figure.

FrRIEEE

(=1~ Training_Project [C++]
B Source

B3 sources

B Indude

-5 ... \indude-gnu

£ ... Nindude-gnuinext

-5 ... \indudes

B[ Verification_(1)

B-75 Source

--E] SOUFCES

-~ Configuration

----- E Training_Project

E-I75 Result
--ﬁ Result_{1) [Verification Completed]
BHES) Result_(2)

- Verification_(2)
E]B Source
| B3B3 sources
Ej fraining.cpp
EE! Configuration
- ETraining_Project
: @ raining_Project_(1)
IE] Result
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Setting the JSF++ Checking Option

You set up JSF++ checking by selecting an option and then selecting the rules

to check. To set the JSF++ checking option:

1 Select the Training_Project_(1) Configuration in the Project Browser.

2 In the Analysis options, select Compliance with standards > Coding

rules checker.

The software displays the JSF C++ rules checker options,

-jsf-coding-rules and -includes-to-ignore.

[=-Coding rules checker

[El-Check 15F C++rules v

- J5F C++ rules configuration

. |Hsf-coding-rules

[=l-Check MISRA C++ rules

i MISRA C++ rules configuration

. |-misra-cpp

----- Files and folders to ignore

. |Hndudes-to-ignore

These options allow you to specify which JSF++ rules to check and which, if

any, files to exclude from the code analysis.

3 Select the Check JSF C++: rules check box.

Creating a JSF++ Rules File

You must have a rules file to run a verification with JSF++ checking. You
can use an existing file or create a new one. You create a new rules file for

this tutorial by:

® “Opening a New Rules File” on page 5-7
e “Setting All the Rules to Off” on page 5-9

® “Selecting the Rules to Check ” on page 5-9

Opening a New Rules File
To create a new rules file:

1 Click the browse button J to the right of the JSF C++ rules

configuration option.
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A table of rules appears.

C:\PohrSpace\Training_Pro]'ect\isf.brt ﬂ
File
J 0o\
Set the following state to all J5F C++rules @ IErru:ur - I GO |
Rules Error Warning off Comments

JSF AV rules -

- Mumber of rules by mode : 1 1 232

[#-Code Size and Complexity - Rules 1to 3

[+-Rules -Rules 410 7

----- Terminology

[+-Environment - Rules 8 to 15

[+-Libraries - Rules 16 to 25

[#]-Pre-Processing Directives - Rules 26 to 32

[+-Header Files - Rules 33 to 39 ]
[#]-Implementation Files - Rule 40

[-Style - Rules 41 to 63

[+-Classes - Rules 64 ta 97.1

[+-MNamespaces - Rules 98 to 100

[+-Templates - Rules 101 to 106

[+-Functions - Rules 107 to 125

[+-Comments - Rules 126 to 134

[-Dedaration and Definition - Rules 135 to 141 =

oK Cancel |
2 For each rule, you can specify one of the following states.
State Causes the verification to...
Error End after the compile phase when this rule is
violated.
Warning Display warning message and continue verification
when this rule is violated.
Off Skip checking of this rule.




Setting Up Coding Rules Checking

Note The default state for most rules is Warning. The state for rules that
have not yet been implemented is Off. Some rules always have a state of
Error (you cannot change this state).

Setting All the Rules to Off

In this tutorial, you check only a few rules. Therefore, first set the state of all
rules to Off. Later, you can select the specific rules that you want to check.

To set the state of all rules to Off:
1 From the Set the following state to all Jsf menu, select Off .
2 Click Go.

Selecting the Rules to Check

To select the rules to check for this tutorial:
1 Expand the set of rules named Type Conversions - Rules 177 to 185.
2 Select the Warning column for rule 180.

3 Expand the set of rules names Flow Control Structures - Rules 186
to 201.

4 Select the Error column for rule 191.

5 Click OK to save the rules and close the window.
The Save as dialog box opens.

6 In File, enter jsf.txt

7 Click OK to save the file and close the dialog box.
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Excluding Files from JSF++ Checking

You can exclude files from JSF++ checking. You might want to exclude some
included files. To exclude math.h from the JSF++ checking of the project

Training_Project.cfg:

1 Click the button J to the right of the Files and folders to ignore option.

The Files and folders to ignore (includes-to-ignore) dialog box opens.

~Files and directories to ignore [-includes-to-ignore]

-

COPolySpacetsourcesinath b
CPolySpacetzourcesmatriz b

CPolySpaceizourcestincludes

Ok Cancel

2 Click the folder icon.

The Select a file or folder to include dialog box appears.

3 Navigate to the polyspace _project folder.
4 Select the includes folder.
5 Click OK.
The includes folder appears in the list of files to ignore.

6 Click OK to close the dialog box.
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Configuring Text and XML Editors

Before you check JSF++ rules, you should configure your text and XML
editors in the Preferences. Configuring text and XML editors allows you to
view source files and JSF reports directly from the Coding Rules perspective.

To configure your text and .XML editors:

1 Select Options > Preferences.
The Preferences dialog box opens.
2 Select the Editors tab.

The Editors tab opens.

x

Tools Menu | Remate Launcher
Miscellaneous | Result directory | Default directory Editors | Generic targets
~XML editor configuration

Specify the full path to a XML editor or use the browse button.

XML Editor: IC:'n,Prugram FilesMsOffice \Office 12\EXCEL . EXE _}l

~Text editor configuration

Specify the full path to a text editor or use the browse button.

Text Editor: IC: \Program Files\Windows NT \Accessories wordpad.exe _}l

Spedfy the command line arguments for the text editor,

Arguments: ISFILE

The following macros can be used SFILE, SLIME, SCOLUMM

(o] Apply Cancel

3 Specify an XML editor to use to view JSF++ reports. For example:

C:\Program Files\MSOffice\Office12\EXCEL.EXE
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4 Specify a Text editor to use to view source files from the Launcher logs.
For example:

C:\Program Files\Windows NT\Accessories\wordpad.exe

5 Specify command line arguments for the text editor. For example:

$FILE
6 Click OK.

Saving the Project

Save your project to save your new verification and analysis settings.
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Running a Verification with Coding Rules Checking

In this section...

“Starting the Verification” on page 5-13
“Examining JSF C++ Violations” on page 5-15
“Opening JSF Report” on page 5-17

Starting the Verification

When you run a verification with the Check JSF C++ rules option selected,

the verification checks most of the JSF++ rules during the compile phase. If
there is a violation of a rule with state Error, the verification stops.

Note Some rules address run-time errors.

The verification stops if there is a violation of a rule with state Error.

To start the verification:

1 Select Verification_(2) in the Project Browser.

2 Click the Run button > 2"

on the Project Manager toolbar.

The verification fails because of JSF++ violations. The message
“Verification Failed” appears at the bottom of the Project Manager
perspective, and the Output Summary indicates that the verification has

detected JSF errors.
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& Output Summary - [C:\PolySpace\Training_Project\Verification_(2)\Result_(1)]

Class Description File Line Col
i Training_Praject for C++ verification start at Jun 29, 2010 17:33: 15 -
t
] Exiting because of previous error -
Detail:
Error:

WVerifier has detected J5F error(s) in the code.

@ Full Log | i Verification Statistics Progress Monitor Qutput Summary
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Examining JSF C++ Violations
To examine the JSF++ violations:

1 Double-click JSF-report.xml in the Project Browser Result folder.

The Coding Rules perspective appears, displaying a list of JSF++ violations.

PolySpace - C:\PolySpace\Training_Project\Verification_(2)\Result_(1)\PolySpace-Doc)1SF-reportacml - IEI|5|
File Edit Run Review Options Window Help
% E | ‘ & By @ ‘ % o | @ ‘ ‘ @ijectl"‘la"lager < Coding Rules & Run-Time Checks
@ Assistant,.. @ B % |0 J5F C++ o
+ 1+ Hherl [~ Hide justifed violated rules i
Rule | File | Line | Col | wfe Rule File Line col | Classification Status | Justified Comment
|warning 180 training. cpp 21 [ [l
|error 191 training.cpp 45 19 [l
“|warning 180 training.cpp 109 15 [
warning 180 training. cpp 142 "] r

=" Rule details

0% Ready

2 Click on any of the violations to see a description of the violated rule, the
full path of the file in which the violation was found, and the source code
containing the violation.
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PolySpace - G\ PolySpace\Training_Project\Verification_(2)\Result_(1)\PolySpace-Doc)1SF-reportaxcml - |EI|5|
File Edit Run Review Options Window Help
Iﬁ H = = ‘ ¥ E E ‘ % [*) | @] ‘ @Projectlvlanager A Coding Rules & Run-Time Checks

4+ ¢+ Filter I [ Hide justifed violated rules i

Rule | File I U"EI Col I wfe Rule File Line Col Classification Status Justified Comment
|warning 180 training. cpp 21 ] [
training.cpp
“Jwarning 180 training.cpp 109 15
Warning 180 training.cpp 142 38

Al

Rule detai .

Bule: 191 (error): The break statement shall not be used (except to terminate the cases of a switch statement).

File: C:\PolySpace\polyspace projecth\sources‘\training.cpp line 46 (column 19)

| 0% Ready

The log reports a violation of rule 191. A break statement is used in
training.cpp.

3 Right click the row containing the violation of rule 191 , then select Open
Source File.
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_

warning

Cpen Source File

warning

150

%% Configure Editor

Open J5F Report

Add Pre-Justification to Clipboard

Filter I [T Hide justifed violated rules
w/fe Rule File Line Col
warning 130 training.cpp 21

The training.cpp file opens in your text editor.

Note You must configure a text editor before you can open source files.
See “Configuring Text and XML Editors” on page 5-11.

4 Correct the JSF++ violation and run the verification again.

The verification will complete, and the results will be the same as those
from the tutorial in Chapter 3, “Running a Verification”.

Opening JSF Report

After you check JSF++ rules, you can generate an XML report containing all
the errors and warnings reported by the JSF C++ checker.

Note You must configure an XML editor before you can open a JSF report.
See “Configuring Text and XML Editors” on page 5-11..

To view the JSF report:

1 Click the Coding Rules button in the Polyspace Verification Environment

toolbar.

A list of JSF++ violations appears in the Coding Rules perspective.
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2 Right click any row in the log, and select Open JSF Report.

Filter I [T Hide justifed violated rules
w/fe Rule File Line Col I
warning 180 training.cpp 21 8

Cpen Source File

warning
warning 130 Add Pre-Justification to Clipboard

Open J5F Report
%% Configure Editor

The report opens in your XML editor.

HY9-o- )+ Bookl - Microseft Excel =X
| Home | Insert  Pagelayout  Formulas  Data  Review  View  Adddns  Acrobat @ - o x
s < — galnsert~ | E -
j # cabr lu -lAa| = i Wrap Text Ere = ﬂ ﬁ g G Insel ﬂ B
. = == 3 Delete - E E

Sort & Find &
Filter = Select~

(& A |

Merge & Center - | | $ - % » ||%3 08| | Conditional Format cCell ||
2 | = H -)| Farmatting = as Table ~ Styles = fEH Format - || 2~

F} Alignment ) Mumber (F} Styles Cells Editing
A B C D E F G

1 ge

2 180 shall warning C:\PolySpace\polyspace_project\sources\training.cpp 21 8 | Implicit conversions that may result in a loss of information sk
3 191 shall errar C:\Polyspace\polyspace_project\sources\training.cpp 46 19 | The break statement shall not be used (except to terminate tf
4 180 shall warning C:\PolySpace\polyspace_project\sources\training.cpp 109 15 | Implicit conversions that may result in a loss of information s
5 180 shall warning C:\PolySpace\polyspace_project\sources\training.cop 142 38 | Implicit conversions that may result in a loss of information s
6
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